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Abstract
This paper provides information for driver developers about the tracing and logging features for the Universal Serial Bus (USB) in Windows® 7. It includes information on how to install the tools, create trace files, and analyze the events in a USB trace file.
This paper assumes that the reader has a comprehensive understanding of the USB ecosystem and hardware that is required to successfully use the USB tracing and logging features. To interpret the event traces, the reader also requires an in-depth understanding of the Windows USB core driver stack, the USB 2.0 Specification, and the USB Device Class Specifications.
This information applies to the Windows 7 operating system.
References and resources discussed here are listed at the end of this paper.
The current version of this paper is maintained on the Web at: 
	http://www.microsoft.com/whdc/connect/usb/Event-Tracing.mspx
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[bookmark: _Toc251075861][bookmark: _Toc255205282]Introduction to USB Event Tracing
This paper provides information on Event Tracing for Windows® (ETW) and on Universal Serial Bus (USB) support for ETW.
This information is provided for the benefit of those who develop and debug USB devices. All USB ETW events and structures are subject to change in the future without notification. We strongly recommended that you do not build tool sets based on USB ETW events or structures.
[bookmark: _Toc251075862][bookmark: _Toc255205283]Background on Event Tracing for Windows
ETW is a general-purpose, high-speed tracing facility that is provided by the operating system. It uses a buffering and logging mechanism that is implemented in the kernel to provide a tracing mechanism for events that are raised by both user-mode applications and kernel-mode device drivers. Additionally, ETW provides the ability to dynamically enable and disable logging, which makes it easy to perform detailed tracing in production environments without requiring reboots or application restarts. The logging mechanism uses per-processor buffers that are written to disk by an asynchronous writer thread. This buffering allows large-scale server applications to write events with minimum disturbance.
ETW was introduced in Windows 2000. Since then, various core operating system and server components have adopted ETW to instrument their activities. ETW is now one of the key instrumentation technologies on Windows platforms. A growing number of third-party applications use ETW for instrumentation, and some take advantage of the events that Windows provides. ETW has also been abstracted into the Windows preprocessor (WPP) software tracing technology, which provides a set of easy-to-use macros for tracing printf-style messages for debugging during development.
ETW was significantly upgraded for Windows Vista® and Windows 7. One of the most significant new features is the unified event provider model and APIs. In short, the new unified APIs combine logging traces and writing to the Event Viewer into one consistent, easy-to-use mechanism for event providers. At the same time, several new features have been added to ETW to improve the developer and end-user experiences.
For more information about ETW and WPP, see “Resources” at the end of this paper.
[bookmark: _Toc251075863][bookmark: _Toc255205284]The Need for USB ETW
USB is one of the most prevalent means of connecting an ever-increasing variety of peripheral devices to PCs. There is a very large installed base of USB host PCs and USB peripheral devices, and system vendors, device vendors, and end users expect and demand that USB devices operate flawlessly at the system and device level.
The large installed base and proliferation of USB devices have uncovered compatibility issues between the Windows USB software stack, the USB host controller, and USB devices. These compatibility issues cause problems for customers such as device operation failures, system hangs, and system crashes.
It has been difficult or impossible to investigate and debug USB device issues without direct access to the system, and/or devices, or in some cases a system crash dump. Even with full access to the hardware and a crash dump, extracting the relevant information has been a time-intensive technique that is known only by a few core USB driver developers. You can debug USB problems by using hardware or software analyzers, but they are very expensive and are available to only a small percentage of professionals.
In Windows 7, ETW provides an event logging mechanism that the USB driver stack can exploit to aid in investigating, diagnosing, and debugging USB-related issues. USB driver stack ETW event logging supports most or all debugging capabilities that are provided by the existing ad hoc logging mechanism in the USB driver stack, without any of its limitations. This translates into ease of debugging USB-related issues, which should provide a more robust USB driver stack in the long term.
[bookmark: _Toc251075864][bookmark: _Toc255205285]USB Support for ETW Logging
We added ETW logging to the USB host controller drivers and to the USB hub driver in Windows 7. The USB host controller driver layer includes the host controller port driver (usbport.sys) and the miniport drivers (usbehci.sys, usbohci.sys, and usbuhci.sys). The USB hub driver layer consists of the USB hub driver (usbhub.sys).
The USB driver ETW event providers are included in all editions and SKUs of Windows 7.
[bookmark: _Toc251075865][bookmark: _Toc255205286]USB Hub Events
While USB event collection is enabled, the USB hub event provider reports the addition and removal of USB hubs, the device summary events of all hubs, and port status changes. You can use these events to determine the root cause of most device enumeration failures.
[bookmark: _Toc251075866][bookmark: _Toc255205287]USB Port Events
While USB event collection is enabled, the USB port event provider reports I/O from client drivers, opening and closing of device endpoints, and miniport state transitions such as miniport start and stop. Logged I/O includes requests for the state of physical USB ports. State transitions on physical USB ports are one of the key initiators of activity in the core USB driver stack.
[bookmark: _Toc251075867][bookmark: _Toc255205288]Using USB ETW
Table 1 lists the tools that you can use to enable USB ETW logging and to analyze an event trace log.
Table 1. USB ETW Tools
	Task
	Tool
	Description

	Capture a USB event trace
	Logman
	A tracing tool that is built into Windows. You can use Logman to capture events into an event trace log file.
For more information, see “Recording an Event Trace by Using Logman” later in this paper.

	Analyze an event trace log to troubleshoot a failure
	Network Monitor (Netmon)
	A full-featured monitoring tool for analyzing network traffic and monitoring and managing devices. You can also use Netmon to examine event trace logs. We provide a USB ETW event parser for Netmon that enables Netmon to clearly present the details of USB events in a log. 
You should use Netmon to examine the events for a device that is failing.
For more information, see “Installing Netmon and the Netmon USB Parser” later in this paper.

	Capture a system event trace and analyze timing or performance issues
	Xperf
	An ETW controller and consumer for analyzing system and application performance in Windows. 
You can use Xperf alone, or together with Netmon, to analyze timing or performance issues with USB devices.
For more information, see “Using Xperf with USB ETW” later in this paper.



[bookmark: _Using_PERFMON_USB][bookmark: _Using_XperfPERFMON_with][bookmark: _Recording_an_Event][bookmark: _Toc251075868][bookmark: _Toc255205289]Recording an Event Trace by Using Logman
You can use the Logman tool to capture a USB ETW event trace.
Event trace log files can grow very quickly, but a smaller log file is easier to navigate and easier to transmit. Before you start a trace, consider taking the following steps to exclude extraneous events from the log so that you can focus on the device activity that you want to examine:
Disconnect any non-critical USB devices that are not the device of interest.
If your system has a USB keyboard or mouse, enter the trace commands by using Remote Desktop instead.
Narrow the start and the end of the trace as much as possible around the operations of interest.
If you are interested in only a certain category of USB events, you can use keywords to filter the events that are recorded. For more information, see “Creating a Smaller Event Log by Filtering USB Events” later in this paper.

To collect USB trace information by using Logman
1. Open a command-prompt window that has administrative privileges. To do so, click Start, type “cmd” in the search box, right-click cmd.exe, and then select Run as administrator.
2. In the command-prompt window, enter the following two commands to begin the trace:
Logman start Usbtrace -p Microsoft-Windows-USB-USBPORT -o usbtrace.etl -ets -nb 128 640 -bs 128

Logman update Usbtrace -p Microsoft-Windows-USB-USBHUB -ets

After each of these commands completes, Logman should display the following message: 
	“The command completed successfully.”
3. Perform the steps in your USB device usage scenario.
4. Stop USB hub and port event collection by running the following command:
Logman stop Usbtrace –ets


5.	After completion of these commands, you will see a file that is named usbtrace.etl in the current directory, which is usually C:\Windows\system32. You can close the command-prompt window.
[bookmark: _Filtering_USB_Events][bookmark: _Creating_a_Smaller][bookmark: _Toc251075869][bookmark: _Toc255205290]Creating a Smaller Event Log by Filtering USB Events
You can use ETW keywords to filter the events that USB drivers write to a trace log. Currently, the most useful keyword for USB devices is the USB port driver’s PowerDiagnostics flag. When you use this keyword, the port driver logs host-controller and endpoint information but omits all events that describe transfers. If you do not need to see the transfer events, you can use the PowerDiagnostics keyword to reduce the size of a trace log by as much as 85 percent. Specify the PowerDiagnostics keyword when you start the trace, as shown in the following example:
Logman start Usbtrace -p Microsoft-Windows-USB-USBPORT PowerDiagnostics -o usbtrace.etl -ets -nb 128 640 -bs 128

Logman update Usbtrace -p Microsoft-Windows-USB-USBHUB –ets

If your filtered trace log has many host controller asynchronous schedule enable and disable events, you can filter them out when viewing the log by using a Netmon filter, as shown in the following example:
NOT (Description == "USBPort_MicrosoftWindowsUSBUSBPORT:Host Controller Async Schedule Enable" OR Description == "USBPort_MicrosoftWindowsUSBUSBPORT:Host Controller Async Schedule Disable")

For more information on Netmon filters, see “USB Netmon Filters” later in this paper.
Sometimes it is helpful to have the transfer events in your trace log, such as hub requests and device requests that result in errors such as an XACT error or a stall. You might first capture a log without the transfer events and analyze that smaller log. Then run the trace again without filtering after you have a general understanding of the issues in your problem scenario.
[bookmark: _Installing_Netmon_and][bookmark: _Toc251075870][bookmark: _Toc255205291]Installing Netmon and the Netmon USB Parser
The Netmon tool is very helpful for examining USB event trace logs when you use it with the Netmon USB parser. You install Netmon from the Microsoft Download Center, and you install the Netmon USB parser from CodePlex, which is the Microsoft open-source project site.
The Netmon USB parser is supported in Netmon Version 3.3 and later versions.
To install the Netmon tool and the Netmon USB parser
1. Determine whether your machine is running 32-bit Windows or 64-bit Windows:
a. On the Start menu, right-click Computer, and then select Properties.
b. Look at the System type field.
i. If your system type is 32-bit Operating System, you will use the x86 download.
ii. If your system type is 64-bit Operating System and your processor is Itanium, you will use the ia64 download. For other processor types, use the x64 or AMD64 download.

2. Install Netmon:
a. Go to the Windows Network Monitor page in the Microsoft Download Center and read the description of the tool.
b. Go to the Files in this Download section toward the bottom of the page and click the Download button for your system type.
c. Download and run the .exe file.
d. When the Setup Wizard presents the Choose Setup Type dialog box, select Typical.

3. Install the Netmon parser set:
a. Go to the CodePlex parsers Web page.
b. On the Downloads tab, select the Microsoft Parsers package that matches your system type. For example, if you have an x86 system, choose Microsoft_Parsers_x86.msi.
c. Download and run the MSI installer.
d. When the Setup Wizard asks you whether you want to upgrade the installed parsers, select Yes.
e. When the Setup Wizard presents the Choose Setup Type dialog box, select Typical.

4. Activate the Windows parsers:
a. Run Netmon. It is listed in the Start menu as Microsoft Network Monitor 3.3.
b. On the Tools menu, select Options.
c. On the Parser tab, select Windows parsers. Click the Stubs button above the list of parsers to deactivate stubs and to use full parsers. Your settings should look like the dialog box in Figure 1.
[image: Netmon options configuration]
	Figure 1. Configuring Netmon to use full Windows parsers
d. Click OK.
e. Restart Netmon.
Netmon is now configured for use with a USB ETW trace file.
[bookmark: _Toc251075871][bookmark: _Toc255205292]Examining a Trace File using Netmon
After you install Netmon and configure it for use with USB ETW files, you can use it to examine a trace file.
To use Netmon to examine a trace file
1. Run Netmon. It is listed in the Start menu as Microsoft Network Monitor 3.3.
2. Open the trace file by using one of the following methods:
On the File menu, click Open, click Capture, and then select the .etl file.
Click the Open Capture button and select the .etl file.
Press CTRL+O and select the .etl file.

3. Observe that the events are listed in the Frame Summary pane. Note the following columns in this pane:
a. Time Offset: The timestamp for the event, specified as an offset from the start time of the log.
b. Protocol Name: The driver that logged the event. For USB events, the driver is USB Hub or USB Port.
c. Description: A descriptive name for the event.

4. Select an event in the Frame Summary pane. Netmon displays the details for the event in the Frame Details and Hex Details panes.
5. In the Frame Details pane, expand the items to examine the details of the event.

For an example of using Netmon to examine a USB trace file, see “Troubleshooting an Unknown USB Device by Using ETW and Netmon” later in this paper.
[bookmark: _Troubleshooting_an_Unknown_1][bookmark: _Toc251075872][bookmark: _Toc255205293]Troubleshooting an Unknown USB Device by Using ETW and Netmon
This section provides an example of how to use USB ETW and Netmon to troubleshoot a USB device that Windows does not recognize. For this example, we plugged in a device and it appeared as an unknown device in Device Manager and other parts of the user interface (UI). The Hardware ID was USB\UNKNOWN. To diagnose further, we unplugged the device, began an ETW trace, and plugged in the device again. After the device appeared as an unknown device, we stopped the trace.
[bookmark: _Toc251075873][bookmark: _Toc255205294]Background on the Unknown Device Problem
To debug an unknown USB device problem, it helps to understand what the core USB drivers do to enumerate a device when a user plugs it into the system. For information on USB enumeration, see the blog post titled “How does USB stack enumerate a device?” on MSDN®.
Typically when the USB core drivers fail to enumerate a device, the hub driver still reports the arrival of the device to Windows and the USB device is marked as an unknown device in Device Manager. The device has a Device ID of USB\VID_0000&PID_0000 and a Hardware ID and Compatible ID of USB\UNKNOWN. The following events cause the USB hub driver to enumerate a USB device as an unknown device:
A port reset request timed out during enumeration.
The Set Address request for the USB device failed.
The request for the USB device's Device Descriptor failed.
The USB Device Descriptor was malformed and failed validation.
The request for the Configuration Descriptor failed.
The USB Configuration Descriptor was malformed and failed validation.

In Windows 7, unknown devices that fail enumeration are marked with failure Code 43 in Device Manager.
If a device is marked with failure Code 28 in Device Manager, the device enumerated successfully but is still an unknown device. This failure code indicates that the device did not provide a Product ID string during enumeration and Windows could not find a matching INF for the device to install a driver.
[bookmark: _Toc251075874][bookmark: _Toc255205295]Starting the Event Trace Analysis
Because this is a device failure, we recommend that you use Netmon with the USB parser to analyze the log file. You can perform the analysis as you read this paper by using the event trace log file (devicefailure.etl) that is posted on the WHDC Web page with this paper. 
To view the event trace log
1.	Run Netmon, click File -> Open -> Capture, and then select the file.
2.	Select the first event in the Frame Summary pane, which has the description SystemTrace. 
Figure 2 shows what the screen looks like when you select the first event. 
[image: http://blogs.msdn.com/blogfiles/usbcoreblog/WindowsLiveWriter/AnsweringthequestionWhatswrongwithmydevi_F304/netmon2-1_4.png]
Figure 2. The first event in the trace
3.	To customize the columns that Netmon displays, right-click a column name and select Choose Columns.
4.	The first event, which is identified as type SystemTrace, contains general information about the log. You can expand the information tree in the Frame Details pane to see information such as the number of events lost and the trace start time.
[bookmark: _Toc251075875][bookmark: _Toc255205296]USB Device Summary Events
Event 2 is the first USB event in the log. This and several subsequent events describe the USB host controllers, hubs, and devices that were connected to the system when we started the trace. We can call this group of events the device summary events, or just summary events. Like the first event, the summary events do not describe driver activity. Summary events record the state of the devices at the start of a logging session. Other events represent something happening on the bus, interactions with client drivers or the system, or changes of internal state.
The USB hub and USB port drivers both log summary events. The driver that logged an event is identified in the Protocol Name column. For example, an event that is logged by the USB port driver has the USBPort_MicrosoftWindowsUSBPORT protocol name. A USB event trace typically contains a sequence of port summary events, followed by a sequence of hub summary events. Many of the USB port and USB hub summary events have the words “Information” or “Attributes” in their description.
How can you identify the end of the summary events? If there is a significant break in the timestamp pattern among the USB hub events at the start of the log, that break is probably the end of the device summary. Otherwise, the first USB port event after any USB hub events is likely the first non-summary event. Figure 3 on the following page shows the first non-summary event in this sample trace.
In this example, the device of interest was not connected to the system when we started the trace, so you can skip the device summary events for now.
[image: http://blogs.msdn.com/blogfiles/usbcoreblog/WindowsLiveWriter/AnsweringthequestionWhatswrongwithmydevi_F304/netmon2-2_4.png]
Figure 3. The first event after the device summary events
[bookmark: _Toc251075876][bookmark: _Toc255205297]Event Description and Data Payload
In the sample log, the first event after the device summary events is a USB Hub Wait Wake IRP Completed event. We plugged in a device, and a host controller or a hub is waking up in response. To determine which component is waking up, look at the event's data. The data is in the Frame Details pane, which is shown in a tree structure in approximately the following form:
Frame information
ETW event header information
    ETW event descriptor (Constant information about the event ID such
    as error level)
Event payload (Data logged at the time of the event)
    Name of a USB-specific structure
        Structure members and their values (Types: numbers, strings,
        or arrays)
    ...

Expand the payload data for the USB Hub Wait Wake IRP Completed event, and you will see an ETW structure that is named fid_USBHUB_Hub. The name of the structure has the following components:
fid_
 A typical prefix for a USB ETW structure.
USBHUB_
An indication that the USB hub driver logged the event.
The rest of the string
The name of the object that the structure's data describes. For this event, it is a Hub object.

The USB hub driver uses the fid_USBHUB_Hub structure to describe a USB hub. Events that have this hub structure in their data payload refer to a hub, and we can identify the specific hub by using the contents of the structure. Figure 4 shows the Frame Details pane, with the fid_USBHUB_Hub structure expanded to show its fields.
[image: http://blogs.msdn.com/blogfiles/usbcoreblog/WindowsLiveWriter/AnsweringthequestionWhatswrongwithmydevi_F304/netmon2-3_2.png]
Figure 4. Event data payload with fid_USBHUB_Hub structure
The hub structure is very similar to two other structures that commonly appear in USB ETW events: fid_USBHUB_Device and fid_USBPORT_Device. The following important fields are common to all three structures:
fid_idVendor
The USB Vendor ID (VID) of the device.
fid_idProduct
The USB Product ID (PID) of the device.
fid_PortPath
The list of one-based hub port numbers through which a USB device is attached. The number of port numbers in the list is contained in the PortPathDepth field. For the root hub devices, this list is all zeros. For a USB device that is connected directly to a root hub port, the value in PortPath[0] is the root hub port number of the port to which the device is attached. For a USB device that is connected through one or more additional USB hubs, the list of hub port numbers starts with the root hub port and continues with the additional hubs (in the order of distance from the root hub). Ignore any zeros.
For example: 
	Sample Value
	Description

	[0, 0, 0, 0, 0, 0]
	The event refers to a root hub (a port on the PC, directly controlled by a USB host controller).

	[3, 0, 0, 0, 0, 0]
	The event refers to a hub or a device that is plugged into a root hub's port number 3.

	[3, 1, 0, 0, 0, 0]
	A hub is plugged into a root hub's port 3. The event refers to a hub or a device that is plugged into this external hub's port 1.



You should monitor the port paths of any devices of interest. When a device is being enumerated, the VID and PID are unknown and logged as 0. The VID and PID do not appear during some low-level device requests such as reset and suspend. These requests are sent to the hub that the device is plugged into.
In our sample log, the Wait Wake completion event has a port path with six zeroes. The event indicates a Wait Wake action on a root hub. That is logical because of our actions: we plugged the device into a root hub port, so the root hub is waking up.
[bookmark: _USB_Netmon_Filters][bookmark: _Toc251075877][bookmark: _Toc255205298]USB Netmon Filters
You can examine each event in a log in chronological order, if you have the time. Even with experience, it is difficult to quickly identify the important events by scanning the list of the event descriptions. To find the cause of the Unknown Device more quickly, you can use the Netmon filter feature.
The USB Error Filter
To activate the USB error filter in Netmon, click Filter -> Display Filter -> Load Filter -> Standard Filters -> USB -> USB Hub Errors, and then click Apply in the Display Filter pane.
The USB error filter narrows the list of events to only those that meet the criteria shown in the following table.
	Filter text
	Explanation

	(USBPort_MicrosoftWindowsUSBUSBPORT AND NetEvent.Header.Descriptor.Opcode == 34)
	USB port events that have opcode 34 are port errors.

	 OR
	 

	(USBHub_MicrosoftWindowsUSBUSBHUB AND NetEvent.Header.Descriptor.Opcode == 11)
	USB hub events that have opcode 11 are hub errors.

	 OR
	 

	(NetEvent.Header.Descriptor.Level == 0x2)
	Events that have level 0x2 are usually errors.

	 OR
	 

	(USBHub_MicrosoftWindowsUSBUSBHUB AND NetEvent.Header.Descriptor.Id == 210)
	USB hub events with ID 210 are ”USB Hub Exception Logged” events. For more information, see “Understanding Error Events and Status Codes,” later in this paper.



Figure 5 shows the smaller set of events that appear in the Frame Summary pane after we applied the USB error filter to our sample trace log.
[image: http://blogs.msdn.com/blogfiles/usbcoreblog/WindowsLiveWriter/AnsweringthequestionWhatswrongwithmydevi_F304/netmon2-4_2.png]
Figure 5. The events that match the USB error filter
To see an overview of the sequence of errors, you can briefly view each error event. Important fields to observe include fid_NtStatus, fid_UsbdStatus, and fid_DebugText. For more information, see “Understanding Error Events and Status Codes” later in this paper.
To turn off a filter, click the Remove button in the Display Filter pane.
Custom Netmon Filters
[bookmark: _Understanding_Error_Events][bookmark: _Toc251075878]You can create custom filters in Netmon. The easiest method is to create a filter from data on the screen in one of the following ways:
Right-click a field in the Frame Details pane and select Add Selected Value to Display Filter
Right-click a field in the Frame Summary pane and select Add [field name] to Display Filter. 

You can change the operators (such as OR, AND, and ==) and the filter values to build the appropriate filter expressions.
For example, you can locate an event in the trace that represents a get-device-descriptor request and right-click some key fields in the control transfer and add them to a filter. When you right-click the DEVICE and GET_DESCRIPTOR fields in the Frame Details pane, Netmon adds an OR of these two conditions to the filter. Change OR to AND and you have a filter for get-device-descriptor requests. This method is limited in that you cannot filter the same field across different event IDs.
[bookmark: _Understanding_Error_Events_1][bookmark: _Toc255205299]Understanding Error Events and Status Codes
In our unknown device example, most of the USB hub exceptions have a fid_DebugText data of CreateDeviceFailure. It is not clear how serious the exception is, but the debug text gives a hint as to the cause: an operation related to the new device failed. For now, assume that the adjacent Create Device Failed events are redundant. The last two exceptions are CreateDeviceFailure_Popup and GenErr_UserIoctlFailed. The popup exception sounds like an error that was exposed to the user, but any and all of these errors could be related to the unknown device problem.
USB error events, and other events, have status values in their data that provide valuable information about the problem. You can find information on status values by using the resources in the following table.
	Status type
	Resource

	fid_NtStatus
	See the “NTSTATUS values” topic on MSDN.

	The status field of a USB request block (URB) or fid_UsbdStatus
	Look up the value as a USBD_STATUS in inc\api\usb.h in the Windows Driver Kit (WDK).
You can also use the “USBD_STATUS” topic in the WDK documentation. This topic lists the symbolic names and the meanings of the USBD_STATUS values.



“Resources” at the end of this paper contains links to the preceding resources.
[bookmark: _Toc251075879][bookmark: _Toc255205300]Reading Backwards from Problem Events
The events that are logged before the error events might provide important clues as to the cause of the error. You should look at the events that are logged before the errors to try to determine the root cause of the unknown device. In this example, start looking backward from the CreateDeviceFailure_Popup event, the second-to-last exception. Select this event while the USB error filter is enabled, and then click Remove in the Display Filter pane. The USB error filter still appears in the Display Filter pane, and you can re-apply it later. But now the filter is disabled and the Frame Summary pane displays all events (as shown in Figure 6 on the following page).
[image: http://blogs.msdn.com/blogfiles/usbcoreblog/WindowsLiveWriter/AnsweringthequestionWhatswrongwithmydevi_F304/netmon2-5_2.png]
Figure 6. The chosen problem event still highlighted after removing the filter
The two events that are logged just before the CreateDeviceFailure_Popup event are a Dispatch and a Complete of a USB control transfer. The fid_USBPORT_Device port path field is zero for both events, which indicates that the transfer's target is the root hub. In the fid_USBPORT_URB_CONTROL_TRANSFER structure of the completion event, the status is zero (USBD_STATUS_SUCCESS), which indicates that the transfer was successful. Continue examining the previous events.
The next two previous events are the fourth (final) Create Device Failed event and fourth (final) CreateDeviceFailure exception, which we examined earlier.
The next previous event is Endpoint Close. This event means that an endpoint is no longer usable. The event data describes both the device and the endpoint on that device. The device port path is [1, 0, 0, 0, 0, 0]. The system on which we ran the trace has only host controllers (root hubs) plus the device that we were connecting, so this port path does not describe a hub. The closed endpoint must be on the single device that we plugged in, and now we know that the device's path is 1. It is likely that the drivers made the device's endpoint inaccessible due to a problem that was encountered earlier. Continue examining the previous events.
The next previous event is a completed USB control transfer. The event data shows that the target of the transfer is the device (the port path is 1). The fid_USBPORT_Endpoint_Descriptor structure indicates that the endpoint's address is 0, so this is the USB-defined default control endpoint. The URB status is 0xC0000004. Because the status is not zero, the transfer was probably not successful. For more details about this USBD_STATUS value, see usb.h and MSDN as described in “Understanding Error Events and Status Codes” earlier in this paper. Those resources provide the following status definition and meaning:
#define USBD_STATUS_STALL_PID ((USBD_STATUS)0xC0000004L)


Meaning: ”The device returned a stall packet identifier”.
What request was stalled by the endpoint? The other data that was logged for the event indicates that the request was a standard device control request. Here is the parsed request:
  Frame: Number = 184, Captured Frame Length = 252, MediaType = NetEvent 
+ NetEvent: 
- MicrosoftWindowsUSBUSBPORT: Complete Internal URB_FUNCTION_CONTROL_TRANSFER 
  - USBPORT_ETW_EVENT_COMPLETE_INTERNAL_URB_FUNCTION_CONTROL_TRANSFER: Complete Internal URB_FUNCTION_CONTROL_TRANSFER 
   + fid_USBPORT_HC: 
   + fid_USBPORT_Device: 
   + fid_USBPORT_Endpoint: 
   + fid_USBPORT_Endpoint_Descriptor: 
   + fid_URB_Ptr: 0x84539008 
   - ControlTransfer: 
    + Urb: Status = 0xc0000004, Flags 0x3, Length = 0 
    - SetupPacket: GET_DESCRIPTOR 
     + bmRequestType: (Standard request) 0x80 
       bRequest: (6) GET_DESCRIPTOR 
       Value_DescriptorIndex: 0 (0x0) 
       Value_DescriptorType: (1) DEVICE 
       _wIndex: 0 (0x0) 
       wLength: 64 (0x40)

Combine the bRequest (GET_DESCRIPTOR) with the Value_DescriptorType (DEVICE), and you can determine that the request was “Get device descriptor”.
For USB enumeration to continue, the device should have responded to this request with its device descriptor. Instead, the device stalled the request, which caused the enumeration to fail. Therefore, all four create-device failures were caused by stalled requests for the device descriptor. You have determined that the device is unknown because enumeration failed and that enumeration failed because the device did not complete the request for its device descriptor.
[bookmark: _Using_Xperf_with][bookmark: _Toc251075881][bookmark: _Toc255205301]Using Xperf with USB ETW
You can use Xperf with Netmon to analyze trace data or to analyze kernel events on the same timeline as a USB trace. Xperf is in the Windows Performance Toolkit, which is part of the Windows Software Development Kit (SDK) for Windows 7. For information about how to download the Windows 7 SDK, see “Resources.”
[bookmark: _Sample_USB_ETW][bookmark: _Analyzing_Sample_USB][bookmark: _Viewing_Event_Trace_1][bookmark: _Using_Xperf_to][bookmark: _Viewing_Event_Trace][bookmark: _Toc248552511][bookmark: _Toc249195877][bookmark: _Toc250465629][bookmark: _Toc251075883][bookmark: _Toc255205302]Viewing a USB Event Trace in Xperf
To analyze performance and timing issues, you can use Xperf to view a USB event trace. For example, if you have an event trace log file that is named usb.etl and you have downloaded the Xperf tool, issue the following command to analyze the trace:
xperf usb.etl


Xperf displays a view of the events in graphical form. The initial view is a timeline view, in which each diamond represents one or more events (see Figure 7). The diamonds are color coded according to the event provider.
[image: cid:image001.png@01CA0162.AAC042F0]
Figure 7. Initial screen in WPA Xperf
The timeline view graphically presents clusters of event activity. In the graphical view, it is easy to see the periodic nature of event activity at 1-second intervals as USB transfer requests that occurred for the USB mass storage device after the device summary events in this example trace.
You can move the mouse pointer across sections of the timeline and zoom in. Figure 8 shows zooming in on the device summary events that occur at the very beginning of the trace.
[image: cid:image001.png@01CAB3B4.6196D300]
Figure 8. Zooming in on the device summary events
You can display an event summary table, in a spreadsheet form, for the entire trace or for just a selected interval (as shown in Figure 9).
[image: cid:image002.png@01CAB3B5.8F871E90]
Figure 9. Event summary table
To display a summary table, right-click in the Generic Events screen (Figure 8) and select Summary Table.
[bookmark: _Toc243885614][bookmark: _Toc244071440]The event summary table is a very powerful view because you can drag the columns to reorder them and the view pivots the events based on the new column order. To enable you to focus on items of interest, you can expand or collapse items with identical sort order.
Sometimes Netmon presents USB event data in a more readable form than Xperf, but Netmon lacks the Xperf timeline and table views. To analyze the trace’s events at a particular period of time, you can switch between Xperf and Netmon.
[bookmark: _Troubleshooting_an_Unknown][bookmark: _Toc255205303]Analyzing USB Performance Issues by Using Xperf and Netmon
Xperf provides a set of kernel events for analyzing performance issues. It records these events and presents them in graphs.
If you are familiar with both Xperf and the USB ETW events, you can create a USB ETW log and an Xperf log of a problem scenario, merge the two log files, and analyze them together. Using Xperf and Netmon together enables you to view both the system events (Xperf) and the USB events (Netmon) for a given scenario.
Start the two traces in parallel by issuing the following commands from an elevated command prompt:
Xperf –on Diag

Logman start Usbtrace -p Microsoft-Windows-USB-USBPORT -o usbtrace.etl -ets -nb 128 640 -bs 128

Logman update Usbtrace -p Microsoft-Windows-USB-USBHUB –ets

Perform the actions for the problem scenario, and then stop the traces by issuing the following commands from an elevated command prompt:
Logman stop Usbtrace -ets

Xperf –stop

Merge the two trace log file into a single file by using the following command (privileges are not required):
Xperf –merge usbtrace.etl C:\kernel.etl merged.etl


This example creates a merged file that is named merged.etl. You can open this file with either the Xperf Performance Analyzer or with Netmon. To open the file in Xperf, run the following command:
Xperf merged.etl


Xperf shows specialized graphs for a wide range of kernel events (as shown in Figure 10). For more information on Xperf recording options and the Xperf GUI, see “Resources”.
[image: ]
Figure 10. Examples of Xperf graphs of kernel events
To open the merged trace log in Netmon, run Netmon, click File -> Open -> Capture, and then select the file. Xperf and Netmon can have the merged file open at the same time. You can switch between the Xperf GUI and Netmon to analyze what was happening in the system and in the USB stack during a particular period of time. You can view the USB events in Xperf, in addition to the system events, but the USB events can be easier to read in Netmon.
By default, Netmon displays all events in the merged trace file. To show only the USB events, apply a filter such as the following:
ProtocolName == "USBHub_MicrosoftWindowsUSBUSBHUB" OR ProtocolName == "USBPort_MicrosoftWindowsUSBUSBPORT"

You can enter this filter text in the Netmon Filter Display pane. For more information on using filters in Netmon, see “USB Netmon Filters” earlier in this paper.
To analyze the timing of USB events, you can look at the time difference between displayed events in Netmon. 
To view the time difference of displayed events
1.	In the Frame Summary pane, right-click a column title, and select Choose Columns. 
2.	In the Disabled Columns list, select Time Delta, click Add, and then click OK.
3.	 Write a filter that displays only the events whose timing you would like to see. For example, to view the delays between non-overlapping bulk-transfer dispatch and complete events, add the following filter:
Description == "USBPort_MicrosoftWindowsUSBUSBPORT:Dispatch URB_FUNCTION_BULK_OR_INTERRUPT_TRANSFER" OR Description == "USBPort_MicrosoftWindowsUSBUSBPORT:Complete URB_FUNCTION_BULK_OR_INTERRUPT_TRANSFER" OR Description == "USBPort_MicrosoftWindowsUSBUSBPORT:Complete URB_FUNCTION_BULK_OR_INTERRUPT_TRANSFER with Data"

a.	You can choose the event IDs (descriptions) from the events that appear in the trace. 
b.	To use an event ID in a filter, right-click an event’s description in the Frame Summary pane and select Add Description to Display Filter.
[bookmark: _Toc251075885][bookmark: _Toc255205304]Tips for Debugging USB Device Problems
[bookmark: _Toc243885615][bookmark: _Toc244071441]This section provides tips for debugging USB device problems.
[bookmark: _Diagnosing_Device_Enumeration][bookmark: _Toc251075886][bookmark: _Toc255205305]Diagnosing Device Enumeration Failures
You can use the ETW events that are associated with the USB hub enumeration task to determine the root cause of most device enumeration failures. 
To view the events in a trace log that are associated with the USB hub enumeration task
1. [bookmark: _Toc243885521][bookmark: _Toc243984810]Open Netmon and locate an enumeration event, such as “Start Enumeration of Port”. Click the event in the Frame Summary pane. 
2. Confirm that the task for this event is USB hub enumeration by examining the Task field for the event:
a. In the Frame Details pane, expand the Net Event, expand the Header, expand the Descriptor, and then locate the Task field.
b. Confirm that the Task field contains the value 2 (USB hub enumeration).
3. Filter the events to show only those from the hub driver that have the task value 2:
a. Right-click the Task field.
b. Select Add Selected Value to Display Filter.
c. Right-click the event in the Frame Summary pane and select Add ‘Protocol Name’ to Display Filter. 
d. In the Display Filter pane, change “OR” to “AND”. The following sample shows the resulting filter:
NetEvent.Header.Descriptor.Task == 0x2 AND ProtocolName == "USBHub_MicrosoftWindowsUSBUSBHUB"


For more information on using filters in Netmon, see “USB Netmon Filters” earlier in this paper.
[bookmark: _Toc243885616][bookmark: _Toc244071442][bookmark: _Toc251075887][bookmark: _Toc255205306]Diagnosing Device Start Failures
[bookmark: _Toc243885597][bookmark: _Toc243984886]If a device fails to start during the hub driver’s handling of the device’s start I/O request packet (IRP), you can use the ETW events that are associated with the USB device start task to troubleshoot the failure. In Netmon, locate a device-start event such as “USB Device Start IRP Dispatched”. You can filter the events to only show those from the hub driver with a task value of 21 (USB device start). For more information on creating such a filter, see “Diagnosing Device Enumeration Failures” earlier in this paper.
[bookmark: _Toc243885617][bookmark: _Toc244071443][bookmark: _Toc251075888][bookmark: _Toc255205307]Profiling Device Insertion Timing
You can determine where time is being spent in the hub driver during device insertion by looking at the timestamps of the enumeration events.
[bookmark: _Toc243885618][bookmark: _Toc244071444][bookmark: _Toc251075889][bookmark: _Toc255205308]Enumeration Timing
The portion of device insertion time that the hub driver consumed to enumerate a device is the time elapsed between the following two events:
Start Enumeration of Port
Enumeration of Port Completed
[bookmark: _Toc243885619][bookmark: _Toc244071445][bookmark: _Toc251075890][bookmark: _Toc255205309]Profiling Enumeration Tasks
When the USB hub driver enumerates a device, it logs the following events in the following order:
Start Enumeration of Port
Enumeration Debounce Completed
PDO Created for Enumeration
First Enumeration Port Reset Complete
Enumeration - CreateDevice Complete
Second Enumeration Port Reset Complete
Enumeration - InitializeDevice Complete
Enumeration - SetupDevice Complete
Enumeration of Port Completed

To determine the time that the hub driver consumed for each enumeration task, calculate the time that elapses between the preceding events.
[bookmark: _Toc243885620][bookmark: _Toc244071446][bookmark: _Toc251075891][bookmark: _Toc255205310]Elapsed Time between IoInvalidateDeviceRelations and IRP_MN_QUERY_DEVICE_RELATIONS
To determine the portion of device-insertion time that the system consumed while it waited for the query device relations IRP, measure the elapsed time between the following two events:
Enumeration of Port Completed
USB Hub Query Device Relations (BusRelations) IRP Dispatched
[bookmark: _Toc243885621][bookmark: _Toc244071447][bookmark: _Toc251075892][bookmark: _Toc255205311]Elapsed Time between Completion of IRP_MN_QUERY_DEVICE_RELATIONS and IRP_MN_START_DEVICE
To determine the portion of device-insertion time between reporting the new physical device object (PDO) to the Plug and Play manager and receipt of the start IRP, measure the elapsed time between the following two events:
USB Hub Query Device Relations IRP Completed
USB Device Start IRP Dispatched
[bookmark: _Toc243885622][bookmark: _Toc244071448][bookmark: _Toc251075893][bookmark: _Toc255205312]Start IRP Timing
To determine the time spent in the hub driver handling the start IRP, measure the elapsed time between the following two events:
USB Device Start IRP Dispatched
USB Device Start IRP Completed
[bookmark: _Toc243885623][bookmark: _Toc244071449][bookmark: _Toc251075894][bookmark: _Toc255205313]Software-Initiated Device Resume Timing
A device’s function driver can send a D0 device power request to resume the device from the suspend state. To determine the required amount of time for the device to resume from suspend and to be ready for transfer requests, measure the elapsed time between the following two events:
USB Device Set D0 Device Power IRP Dispatched
USB Device Set D0 Device Power IRP Completed
[bookmark: _Toc243885624][bookmark: _Toc244071450][bookmark: _Toc251075895][bookmark: _Toc255205314]Hardware-Initiated Device Resume Timing
A resume signal on the bus causes a device to resume from the suspended state. To determine the required amount of time for the device to resume to a state where it is ready for transfer requests, measure the elapsed time between the following two events:
Parent hub is not suspended:
USB Device Wait Wake IRP Completed
USB Device Set D0 Device Power IRP Completed

Parent hub is suspended:
Started Resume of Hub from Selective Suspend (first of these events for any hub between the device and host controller)
USB Device Set D0 Device Power IRP Completed
[bookmark: _Toc243885625][bookmark: _Toc244071451][bookmark: _Toc251075896][bookmark: _Toc255205315]HUB RESUME FROM Selective Suspend Timing
You can determine the required amount of time for a hub to resume from selective suspend by measuring the elapsed time between the following two events:
Started Resume of Hub from Selective Suspend
Resume of Hub Completed

Note: Hub resume timing depends on resume timing of all devices below the hub and possibly some or all hubs above the hub that is being resumed.
[bookmark: _Toc255205316]USB ETW and Power Management
If a USB device driver supports USB selective suspend, it can turn off the USB device when the device is idle. When the device is no longer idle, the system wakes the device and resumes normal operation. When the system is idle and all USB devices are suspended, no processor activity is required and therefore the processer enters a low-power state. Properly implementing selective suspend can result in significant power savings and increased battery life for mobile systems.
You can use USB ETW to examine USB devices and their drivers to validate whether they successfully go into selective suspend. Whether you are a system manufacturer, an IT professional, or a hardware developer, we encourage you to inspect your USB devices and drivers to ensure that they properly support selective suspend before you provide the devices to end users.
To help you identify system energy efficiency problems, we enhanced the Windows PowerCfg utility in Windows 7. PowerCfg is a command-line utility that is included with Windows that enables power policy enumeration and configuration. The enhancements to PowerCfg for determining energy efficiency problems are exercised by using the -ENERGY parameter. These enhancements enable PowerCfg to inspect the system for common energy efficiency problems and generate an HTML report that contains any issues that it found.
PowerCfg detects various energy efficiency problems, including ineffective use of selective suspend by USB devices, excessive processor utilization, increased timer resolution, inefficient power policy settings, and battery capacity degradation. PowerCfg identifies different levels of problems, including server problems (errors) and minor problems (warnings).
For more about Windows power management and the PowerCfg tool, see “Resources”.
[bookmark: _Resources][bookmark: _Toc255205317]Resources
CodePlex
CodePlex Network Monitor Open Source Parsers
http://www.codeplex.com/NMParsers
Device Manager Error Codes
Code 28: The drivers for this device are not installed
http://technet.microsoft.com/en-us/library/cc731268(WS.10).aspx
Code 43: Windows has stopped this device because it has reported problems
http://technet.microsoft.com/en-us/library/cc725873(WS.10).aspx
Event Tracing
Event Tracing
http://msdn.microsoft.com/en-us/library/bb968803.aspx
Event Tracing for Windows (ETW)
http://msdn.microsoft.com/en-us/library/aa468736.aspx
Event Tracing: Improve Debugging And Performance Tuning With ETW
http://msdn.microsoft.com/en-us/magazine/cc163437.aspx
Event Tracing In DirectShow
http://msdn.microsoft.com/en-us/library/dd375628(VS.85).aspx
Netmon
Network Monitor (Netmon) 3.3 Overview
http://channel9.msdn.com/posts/Will+Gregg/Network-Monitor-Netmon-33-Overview/
Power Management
ACPI / Power Management - Architecture and Driver Support
http://www.microsoft.com/whdc/system/pnppwr/powermgmt/default.mspx
Status Values
NTSTATUS values
http://msdn.microsoft.com/en-us/library/cc704588(PROT.10).aspx
USBD_STATUS
http://msdn.microsoft.com/en-us/library/aa476356.aspx
USB
USB 2.0 Specification
http://www.usb.org/developers/docs
USB Device Class Specifications
http://www.usb.org/developers/devclass_docs
Microsoft Windows USB Core Team Blog
http://blogs.msdn.com/usbcoreblog/
How does USB stack enumerate a device?
http://blogs.msdn.com/usbcoreblog/archive/2009/10/31/how-does-usb-stack-enumerate-a-device.aspx
Window Driver Kit
How to Get the WDK
http://www.microsoft.com/whdc/DevTools/WDK/WDKpkg.mspx
Windows Software Development Kit

Windows SDK
http://msdn.microsoft.com/en-us/windows/bb980924.aspx
WPP
WPP Software Tracing
http://msdn.microsoft.com/en-us/library/ms793164.aspx
Xperf
The Xperf Command Line Tool in Detail
http://msdn.microsoft.com/en-us/library/cc305221.aspx
Windows Performance Analyzer (WPA)
http://msdn.microsoft.com/en-us/library/cc305187.aspx
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